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7 Iwﬂaﬂﬁu Save @ ﬁ]ﬂﬁlﬁ/\lﬁﬁﬂaﬂgﬁ%a TokenAgent-Driverx64-installer.exe
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wivnidenyafnaudulssinnseuulianis 32 Un 9e¥e TokenAgent-Driverx32-installer.exe

G Save As >
- ~ I~ & * This PC » Downloads w o Search Downloads
Organize - New folder ®
4 3D Objects & Name Date modified Type size S
i Desktop - Yesterday (1)
* Documents 9 TokenAgent-Driverx64-installer 24/6/2565 1:19 Application 30,382 KB
- Dow-nlnads ~ Earlier this week (8)
» MUS'C (©) eset_nod32_antivirus_live_installer (3) 22/6/2565 17:59 Application 8,302 KB
& Pictures (€) eset_nod32_antivirus_live_installer (2) - Copy 22/6/2565 17:59 Application 8,302 KB
W Videos (€) eset_nod32_antivirus_live_installer (2) 22/6/2565 17:59 Application 8,302 KB
Z. Aom (C) (@) eset_nod32_antivirus_live_installer (1) 22/6/2565 17:52 Application 8,302 KB
~- Aom (D) v BF avg_antivirus_free_setup (1) 22/6/2565 17:24 Application 230 KB v
File name: TokenAgent-DriverxG64-installer .
Save as type: Application =
# Hide Folders 0) Cancel
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¢ Microsoft Word
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2. wdwudandnlwdazusingiesud 9 adndy Run sy @)
Open File - Security Warning X
Do you want to run this file?
. Name: ..om\Downloads\TokenAgent-Driverx64-installer.exe
Publisher: Throughwave (Thailand) Co..Ltd.
Type: Application
From: C:\Users\Aom\Downloads\TokenAgent-Driverx64-in...
@ Run Cancel
Always ask before opening this file
a
UN 9
Y]
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3. AANYY Run ude 2 zilunaaTesiiinisaadniu UAC w38 User Account Control Lite
nseuanlRaRIgeNAwIsAmMIUTEULIIL TiRdndu Yes m:l@: AU 10 winlsdusinganali

auaIINISAnAY (Allow) Widhwsiliunisselude 4

[i’l TokenAgent Setup

Verified publisher: Throughwave (Thailand) Co.,Ltd.
File origin: Downloaded from the Internet

Show more details

5U% 10
4. vaaleFunmseyylianasaInde 3 vise N13EIRARY (Run) Aude 2 asUsINgAagui 11

IindnUy Next any @

cly Setup - TokenAgent version 1.0

Select Components
Which components should be installed?

9.

Select the components you want to install; clear the components you do not want to
install. Click Next when you are ready to continue.

‘Install TokenAgent and SafeNet(Required. If not already installed) v
TokenAgent 12.3 MB
[ SafeNet 46.1 MB

Current selection requires at least 49.2 MB of disk space.

@ ‘ Next | ‘ Cancel
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5. leadindu Next aude 4 wwusingeiaguin 12 Tindndu Install ana ()

ﬁ Setup - TokenAgent version 1.0 - X

Ready to Install
Setup is now ready to begin installing TokenAgent on your computer.

Click Install to continue with the installation, or click Back if you want to review or
change any settings.

Setup type:
Install TokenAgent and SafeNet(Required. If not already installed)

Selected components:
TokenAgent
SafeNet

®)
Back Cancel

Uil 12

6. Lﬁaﬂaﬂﬂn Install 1198 5 %Ui’]ﬂgﬁﬁgﬂﬁ 13 T¥lden Automatically close the
applications mu @) uszadnUu Next nu @)  azUsingzuit 13 dnsdidldnuneriings

[
a o a

Annsyarafailluud mnldusingmugui 13 duilunisanu den 7 seldldlay

1 |—L| Setup - TokenAgent version 1.0 —

Preparing to Install
Setup is preparing to install TokenAgent on your computer.

8] .

® The following applications are using files that need to be updated by Setup. It is
recommended that you allow Setup to automatically close these applications.
After the installation has completed, Setup will attempt to restart the
applications.

PKCS11 Backend

[@ Automatically close the applications ] @

(O Do not close the applications

Back Next Cancel

nsudynans audwaluladansaumanazn1sdeals ngunuimsEULNY 1
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ﬁ Setup - TokenAgent version 1.0 — X

Installing
Please wait while Setup installs TokenAgent on your computer.

Finishing installation...

SafeNet Authentication Client 8.2 for User Rev. 1.2 S... — x
Application Maintenance
Select the maintenance operation to perform. Q fENet.
O Repair
Reinstall missing or corrupt files, registry keys and
%ﬂr shortcuts. Preferences stored in the registry may be resetto
= default values.
| ®@Remove
: @ Uninstall SafeNet Authentication Client 8.2 for User Rev. 1.2
[ 3' ) from this computer. [

(17)

< Back l Neaxt > |I ‘ Cancel ‘

gﬂﬁ 14

' r,
8. e NAANYY Next mude 7 uddvsusngaagui 15 iadnUu Next any @ wwUIng
AIgUT 16 wagaiunismude 9 sely

ﬂ SafeNet Authentication Client 8.2 for User Rev. 1.2 U... — X
SafeNet SafeNet Authentication Client
areiNe : . 8.2 for User Rev. 1.2 Uninstall
Authentication
Client

This will remove SafeNet Authentication Client 8.2 for
UserRev. 1.2

Click Next to continue.
M

@feNet.

o> || cancel |

< Back

Uil 15
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9. 91n3uM 16 1% 1den sy @) uazadindu OK mu ) wazsduiiunismude 10 sioly

]ﬁ'--."."illt ticat ent 8.2 for er Rev. 1.2 S -

Updating System

-,
Please wait while SafeNet Authentication Client 8.2 for User @afeNet
Rev. 1.2 is being uninstalled.

Validating install...

15 safeNet Authentication Client 8.2 for User Rev. 1.2 Setup x
Files In Use =y
Some files that need to be updated are currently @afeNet
in use.

The following applications are using files that need to be updated by this setup.

SACSrv

®

Automartcally close all applications and anempt 1o restart tnem aner setup Is I

() Do not close applications. (A reboct will be required.)
Cancel
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10. wlenanyu OK :nde 9 avusingsiaguit 17 Wiedntu No su ) gniin
aeun1sinfseanlaedaludf nsxvnaseduIzUsIngiagui 18

ﬁSafeNet Authentication Client 8.2 for User Rev. 1.2 S... —
Updating System

Rev. 1.2 is being uninstalled.

-
Please wait while SafeNet Authentication Client 8.2 for User (slafeNet

Removing product settings

=] -
ﬁ Installer Information

Do you want to save the SafeNet Authentication Client
% configuration settings on this computer?

)
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SafeNet Authentication Client 8.2 for User Rev. 1.2 S... - X

SafeNet Authentication Client
SafeNet_ ) 8.2 for User Rev. 1.2 has bee...
Authentication

Client

Click Finish to exit Setup.

M

clg Setup - TokenAgent version 1.0 —

Completing the TokenAgent
Setup Wizard

Setup has finished installing TokenAgent on your computer.

Click Finish to exit Setup.

)

Ul 19

(%
a o a

ofiiumsnsunisindsyafndafussnaufeuios awUsingiegui 18 wazadnUy Finish oy €2)
uazazUsngeegu 19 Wiednda Finish au @) Svlumeuil iluduneunisaenyainduiuvse

Software fiszUUATIINUDN WIS ITURBULRDNTnRAYgARRdLALSUSoe dold THldau nauly

aliunisnnude 1 dnasuiafnnsyafnnssialy
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11. 9nde 5 WeadnUyl Install wagndnilaneunsinfayafnduiuuad vsevin

Window a53aliinuindynfinausiy 9Us1ngaaguin 20 Timdndu Next ey

r\b Setup - TokenAgent version 1.0

Installing

Please wait while Setup installs TokenAgent on your computer.

o .

Finishing installation...

|:Q SafeNet Authentication Client 8.2 for User Rev. 1.2 S...

— X
Welcome to the SafeNet

SafeNet Authentication Client 8.2 for...

Authentication

Cllent The Setup wizard will install SafeNet Authentication
Client 8.2 for User Rev. 1.2 on your computer.
It is strongly recommended that you close all Windows

— f ’ programs before running the Setup wizard. —
Mg Click Next to continue. [
6 3

5UTl 20

12. \ilemdni Next 99n3Ufl 20 asUsngdsgudi 21 Toiadnta Next sy @

|:g SafeNet Authentication Client 8.2 for User Rev. 1.2 S...

Interface Language

X
Select the interface language. @feNe’c

Select the SafeNet Authentication Client 8.2 for User Rev. 1.2 interface lang...

English

v

| < Back | Next >

| Cancel

CaN
[
=b.
N
—_
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13, 93Ul 21 Wendnta Next axusngsegudl 22 Tsindnts Next sy €B)

ﬁ SafeNet Authentication Client 8.2 for UserRev. 1.25...  —

License Agreement y
Please read the following license agreement carefully. (SafeNet

&

SAFENET SOFTWARE LICENSE TERMS ~
SafeNet Authentication Client

Legal notice:

SafeNet software is not sold; rather, copies of SafeNet software are
licensed all the way through the distribution channel to the end user.
UNLESS YOU HAVE ANOTHER AGREEMENT DIRECTLY WITH SAFENET
THAT CONTROLS AND ALTERS YOUR USE OR DISTRIBUTION OF THE
SAFENET SOFTWARE, THE TERMS AND CONDITIONS OF THE

ARPIIAARIFC ILIAFACAT AA~ARCEAACRITA R ALAL ARPDIV TAMALL R

(® | accept the license agreement
(O I do not accept the license agree@t

-

< Back [ Cancel

Ui 22

14. 903Ul 22 Wlemdntu Next awUngfsgud 23 iden Standard wag Adndil
Next »1a @

@ SafeNet Authentication Client 8.2 for User Rev. 1.2S...  — X
Installation Type (\
Select the installation type. @afeNet
(® Standard
=g Standard installation
%E Includes new implementation and user interface for all
O. .
=& eToken and iKey tokens.
(O BSec-compatible
=g Legacy BSec-compatible installation
%g Includes new implementation and user interface for all
= eToken and iKey tokens. Also supports legacy iKey imple...

&
< Back Cancel
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15. 913Ul 23 lendnUy Next avusngeiesuil 24 Tiadndu Next sy @)

@ SafeNet Authentication Client 8.2 for User Rev. 1.25...  — X

Destination Folder (‘
Select a folder in which the application will be installed. \SjafeNet

Setup will install the files for SafeNet Authentication Client 8.2 for User Rev. ...

To install in a different folder, click Browse, and select another folder.

Destination Folder
CAProgram Files\SafeNefAuthentication\ Browse

25)
< Back Cancel

sUdl 24

= A a o Y = & Y P Y a Fa
16. N3UN 24 WerdnUa Next UsNYAUN 25 seaunsenauansnaguin 26 TiadnUa Finish gy @

@ SafeNet Authentication Client 8.2 for User Rev. 1.2S...  —

Updating System

-
Please wait while SafeNet Authentication Client 8.2 for User (SafeNet
Rev. 1.2 is being installed. )

Extracting properties...

Cancel
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SafeNet Authentication Client 8.2 for User Rev. 1.25...  — X

SafeNet Authentication Client
SafeNet. ) 8.2 for User Rev. 1.2 has bee...
Authentication

Client

Click Finish to exit Setup.

>

0 )
M

5UTl 26

17. 9n3Ufl 26 wdsanadndu Finish asusngdsgudt 27 Tiaantu Finish &)

o I
Y a o
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ﬁ Setup - TokenAgent version 1.0 -

Completing the TokenAgent
Setup Wizard

Setup has finished installing TokenAgent on your computer.

Click Finish to exit Setup.

5)

]
=

Jun 27
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1. MIMNEIUYEIENITAIVANNITYBNRDYBIRUNTAl CGD DirectPayment Token Key Uy
Ws1Iwes Google Chrome (TokenAgent Extension)

ASn15ANNY

11!?]'13150&’1‘14 CGD Dlrectpayment Token Key vusy VUIUINEATIIULADULAZAI9UTEINVDY

ﬂill‘UEU‘Uﬂa’Nuu "i]'WL‘LJ‘IN]EN@ﬂ@ﬂﬂ?ﬂﬂﬂ‘u&’iuuﬂ?'5ﬂ'JUﬂ3JﬂT5LSUa§JWE]5UENE]Uﬂ§m LW@ﬂ'J’]JJUaQGmEJLLﬂ
‘U@Hﬁ LLazuﬂ']iL‘U’ﬂ,‘UﬂWu‘U@QiuUUQ’]UE)EJNﬁiJU‘Jim N‘UUM@UﬂWi@ﬂG\Q@Q@@lﬂu

YUNDUNITAAAS
1. 1\ Uaus1iees Google Chrome

2. Copy link mut19d19319 w3eAdN link I1ea1aitelugnisundn Extension TokenAgent

https://chrome.google.com/webstore/detail/tokenagent/npebjcdinfclllhgchljfmkdcloding

U dve1eNYe TokenAgent mugun 28 adnUy IECEREYSITEIEEN (011141

& TokenAgent - Chrome Web Store X +

< C @ chrome.google.com/webstore/detail/tokenagent/npebjcdinfclllt mkdclodir

~ chrome web store

Home > Extensions > TokenAgent

TokenAgent

% % % % % 0 © | DeveloperTools | 217 users

Add to Chrome

Overview Privacy practices Reviews Related

5l 28

3. waenaanaugU AxUsINgAagun 29 TindnUu Add Extension %38 Lilslduvene duveny

%0 TokenAgent 9% add on WlUAd@IU Extension 89 LUSTIL03 Google Chrome L38US08 fasUN 30
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TokenAgent - Chrome Web Store X +

c

@& chrome.google.com/webstore/detail/takenagent/npebjcdinfellihgehljfmkdclodinci/related

= chrome web store

5

L sioy

Home > Extensions > TokenAgent

TokenAgent

L B & & & A RO Developer Tools | 217 users

n Add "TokenAgent"?

It can:

Read and change your data on directpayment.cgd.go.th and

webkitpayment.cgd.go.th

Read your browsing history

Ul 29

<

c

& TokenAgent - Chrome Web Store X+

@ chrome.google.com/webstore/detail/tokenagent/npebjedinfelilhgchlifmkdclodinej/related = w N 0O 4

& chrome web store

Home > Extensions > TokenAgent

TokenAgent
*hhhk 0@

Remove from Chrome

Developer Tools | 217 users

5l 30
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2, 3§m§{]n‘mgiﬂmmﬁmamuzmiﬁw'}mjm CGD Directpayment Token Key

ndleiindinveenisiweusiogunsal CGD Directpayment Token Key L38u3eudd awUsng
dydnualdiuvens Jugy W Tynvuenvesusiiwes  deguil 31 isliusiwesanunsag
anuznsvinuvesgUnsalliegasain  gldeuansalnuyediuvets TokenAgent Lilflouans

anugl lnepdniidayanualty degui 32

e TokenAgent - Chrome Web Store X 4 v -
<« C' @& chromegoogle.com/webstore/detail/tokenagent/npebjedinfclllhgchlifmkddodingj/related e E]El -
& chrome web store £ signin
Home > Extensions > TokenAgent
TokenAgent
T Yo % # ok 0 () | Developer Tools | 217 users
=]
3Un 31
— )
e Y ®» O &
A X

Extensions

No access needed

These extensions don't need to see and change

information on this site.

TokenAgent I
. Pin
£ Manage extensions
a
3Un 32
N Y a £ v L3 ]; P % LY L é’ PN 3 s
INgUN 32 nedndyanual Watnuya asusngdyanualngus © FuALULTITBAUITIYES
U = o dl
un Aegun 33
~ J—
TG * ¢ » O
x

Extensions

No access needed
These extensions don't need to see and change

information on this site.

TokenAgent K

£ Manage extensions
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2. MSIVUABYYIATZUUIIULAAS Pop up %38 Dialog
ASn1snvium

1. 11 @ Ws1Ies Google Chrome
A ccess

2. Aan : (MvuAAILAEAIUAN 1138 customize and control ) TideNiuY faA1MIe Setting
Aagun 34
= Y« O & @
New tab Ctrl+T
New window Ctrl+N
New Incognito window  Ctrl+Shift+N
History >
Downloads Ctrl+J
Bookmarks >
Zoom - 100% + -
Print... Ctrl+P
9 e Cast...
Find... Ctrl+F
.<: More tools »
Edit Cut Copy Paste
Settings
_!', Help »
Exit
UM 34

3. Wedenavusngassun 35 Tiden Jeyadiuuarauazaiulasnsde wie Privacy and

security ﬁﬂ’gﬂﬁ 35

<« (& ® Chrome | chrome://settings
@ Settings Q_ fearch settings
L You and Google
= g You and Google
B  Autofill
Get Google smarts in Chrome
e Privacy and security Sync and personalize Chrome across your devices
@ Appearance Sync and Google services
Q  Search engine
Customize your Chrome profile
BN  Default browser
Import bookmarks and settings
() On startup
@& Languages
3 Downloads
- A ikilis

CaN
[
=b.
()]
[O,]
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4. WeiendNguil 35 AUYNTeRENMATIURBULAZLARIRITUN 36 Tiiden n1saaray

16 %o Site Setting

e

€

g °» ®» & o )

c

1« @&

O© & =+

@ Settings

C  ® Chrome | chrome://settings/privacy

Settings

You and Google
Autofill

Privacy and security
Appearance

Search engine
Default browser

On startup

Languages
Downloads
Accessibility
System

Reset and clean up

x +

Q, Search settings

Safety check

° Chrome can help keep you safe from data breaches, bad extensions, and more

Privacy and security

—  Clear browsing data N
u Clear history, cookies, cache, and more

Privacy Guide N

Review key privacy and security controls

Cookies and other site data
Third-party cookies are blocked in Incognito mode

e Security
Safe Browsing (protection from dangerous sites) and other security settings

Site Settings
Controls what information sites can use and show (location, camera, pop-ups, and more)

14
TI!-

U 36

a

- &

5. 9n3UN 36 Wadenazusngaaguit 37 Widen Jeudnuwaznisiudeundums vie Pop -

Ups and redirects agUsngsisgud 38

@

g » % & @ )

€]

« @&

O & =+

o »

3 Settings - Site Settings

& - C & Chrome | chrome://settings/content

Settings

You and Google
Autofill

Privacy and security
Appearance

Search engine
Default browser

On startup

Languages
Downloads
Accessibility
System

Reset and clean up

Extensions [/]

About Chrome

x +

Q_  Search settings

Microphone
4
Sites can ask to use your microphone

Notifications
a

Sites can ask to send notifications

Background sync
Recently closed sites can finish sending and receiving data

W]

Additional permissions v

Content

& Cookies and site data
Third-party cookies are blocked in Incognito mode

JavaScript

<> P »
Sites can use Javascript

m Images R

Sites can show images

2 Pop-ups and redirects
Sites can send pop-ups and use redirects

Additional content settinas v

Uil 37
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€2 Settings - Pop-ups and redirects X +

<« C @& Chrome | chrome://settings/content/popups =3
G Se‘ttings Q, Search settings
2 Youand Google & Pop-ups and redirects Q_ Search
B Autofill
Sites might send pop-ups to show ads, or use redirects to lead you to websites you may not want to visit
e Privacy and security
Default behavior
@  Appearance
Sites automatically follow this setting when you visit them
Q_  Search engine
@® [/ sites can send pop-ups and use redirects
BN Default browser
() Onstartup @) Kl Don't allow sites to send pop-ups or use redirects
@ Languages Customized behaviors
I Downloads Sites listed below follow a custom setting instead of the default
T Accessibility Not allowed to send pop-ups or use redirects Add
9, System

No sites added

©

Reset and clean up

UM 38
6. mﬂg‘dﬁ 38 Tilden ulasdeiladdduazldnisuldsudunols 13 Sites can send pop-

up and use redirects Waldionizauiosudilvdldaulausriwesls uaulalnidnass
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N19M3IEDUNITANASEIUVENY TokenAgent Extensions

1. [WLUsIes Google Chrome

a 7 ° i - . & 4 a4 a a
2. Aan i (NMUAANLAEAIUAN 198 customize and control ) LN LATDINBLNULA
A I ! . 2 d‘
139 More tools uaztaan auuee (Extensions) Aagun 39
A — [} X
£ %) * 0@
wiilny Ctrl+T
wilginalnad Ctrl+N
vitsindlwsiil lissushaun Ctrl+Shift+N
Usridinsdon 4
aillnan Ctri+)
Ununsh 4
L] - 100% + ::
Wuw.... Ctrl+P
I upaAe...
'o ” D Al Ctrl+F
vuiinmiidudu... Ctrl+S 9 iA3paiiouiIGL »
ATeAn. uily éin Anaon M
sadoniiea. . }
ASEEAN
iuw URL Awdoyamsvioaiu... Ctrl+Shift+Del AMNMuTILEo 3
Auveiy
bhlal
FNARNTITIU Shift+Esc
‘ iedailodmsuilnWRiuwawWsing Ctrl+Shift+|
Golikety TokenAgent Auledduaa...
a
3Un 39

3. UNINYAINIUN 40 Awuansuay Extensions ¥ TokenAgent Wivinmsidially

= ‘. Extensions Q_ [search extensions
Load unpacked Pack extension Update
TokenAgent 0.0.5
PKCS11 Token Key Extension

ID: npebjcdinfclllhgchljfmkdclodincj
Inspect views background page

Details Remove @
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